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1. System Overview 

 

SVO is an image generator system that outputs digital data such as image data. SVO consists 

of software and hardware and firmware on Windows. 

By using this system, it is possible to evaluate the receiving processing of image data, 

image processing, etc. without the device such as the camera. 

The following figure shows the system configuration and the SVO hardware image. 
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2. Operating Environment 

 

○ Hardware 

PC   ： Windows7/8.1 Environment that works fine  

CPU           Core i5 GHz above 

or equivalent CPU 

Memory         4GB above 

Hard disk space   10GB above 

USB Specifications   3.0 must  ※Asmedia-made chips cannot guarantee 

Monitor ： Full color viewable 

他   ： USB3,0 cable etc. 

※Windows10 is currently under evaluation. We will inform you on the website as soon 

as the evaluation ends. 

 

○ Software 

OS   ： Windows7/8.1 64bit/32bit 

他   ： Our applications、Library、 

      Device driver (8.1:64bit only) 
 

3. Software required 

 

The following software is provided for the operation of the SVO system. 

 

・SVOGenerator.exe 

  This is an application that allows you to read and display the image data files of 

 our own, and to output this image data at the specified timing to the target board. 

 

・SVOUSB30.dll 

  The SVO image output library using the USB 3.0 device driver dedicated to the SVO 

 system. You can also incorporate the library into your system without using the above 

 application. 

 

・SVOUSB30.sys、SVOUSB30.inf 

  32bit version of the SVO system dedicated USB 3.0 device driver file. 

 

・SvoU3drv.dll、SvoUdrv.inf、．．． 

  64bit version of the SVO system dedicated USB 3.0 device driver file. 

 

※After SVOGenerator is finished, the following files are generated. 

・SVOGenerator.ini 

  Save the information of the File-option dialog mainly. 

・SVOGenerator.svo 

  Save the information of the Device-Setting dialog mainly. 
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4. SVO Hardware Overview 
 

The SVO hardware (SVO-03) ① Xilinx FPGA (Spartan6-LX16), ② Cypress EZ-USB/FX3, and 

③ SDRAM (128MB) are implemented to achieve the image generator. 

 
 

The host PC is connected to the ④ USB 3.0 port. The ⑤ 50-pin header is used to connect 

the target board to which the SVO is to be output. 

① Xilinx FPGA (Spartan6-LX16) provides SDRAM control, image Generator processing, and 

bus management. 

② The USB 3.0-Cypress Controller （EZ-USB/FX3）provides a control over the USB interface. 

③ SDRAM (128MB) stores the output image data. 

① 

② ③ 

④ 

⑤ 
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5. Install 
 

Contains the software required for the software CD-ROM that is included with the SVO 

hardware. The contents of this CD-ROM are shown in the table below. 

 

Folder Content 

\ This folder contains the  readme. txt, version.txt 

\SVO-AP_x86 This folder contains applications and library associations. 

\SVO-AP_x64 This folder contains the 64-bit version of the above. 

\Driver_x86 This folder contains the SVO-only USB 3.0 Device Driver 

Association 

\Driver_x64 This folder contains the 64-bit version of the above. 

\DOC This folder contains a variety of documents. 

\Image_Output_Library This folder contains the image output library files. 

\Tool This folder contains the Frame file converter utility. 

 

5.1. Installing the SVO-only USB 3.0 device driver 

 

①Connect the SVO board and PC USB 3.0 interface port with the USB 3.0 cable. 
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②Start Device Manager, and then double-click SVO-03. SVO-03 is registered with "Other 

devices" as shown below. 

 
 

③The "SVO-03 Properties" dialog will appear, so click the "Update Driver" button. 
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④"Update Drivers - SVO-03" dialog will appear, so click "Browse my computer for driver 

software". 

 
 

⑤Insert the CD-ROM into the CD drive, select the driver folder with the Browse button, 

and then click the Next button. 
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⑥The installation starts and after a while, the installation ends as shown below. 

 

 
 

 

⑦When you look at Device Manager again, SVO-03 has been registered in the SVO class. 

 
 

※To install the driver to Windows7 32bit, use the device driver stored in the CD-ROM 

driver_x86. 

※If you have previously installed a device driver for the SVI board, you may see "SVO-03" 

under "SVI", but there is no operational problem. 

 

5.2. Application and library-related installations 

 

Copy the SVO-AP_x64 folder in the CD-ROM to any location on your hard disk. 

Make sure that the attributes of the destination SVO-AP_x64 folder are read/write. 

 

※The Windows7 32bit version is stored in the SVO-AP_x86 folder on the CD-ROM. The usage 

is identical. 
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6. Uninstall 

 

Provides instructions for removing an application and applications for the SVO-only USB 

3.0 device driver. 

The removal of SVO is usually only 6.2 "application, library-related uninstall". If you 

want to completely uninstall SVO from the PC, please do the "uninstall the SVO only USB 

3.0 device driver". 

 

6.1. Uninstalling the SVO dedicated USB 3.0 device driver 

 

To uninstall a dedicated device driver for SVO, remove SVO-03 in Device Manager.  Check 

"Delete the driver software for this device" as shown below. 

 

 

6.2. Uninstalling Applications and libraries 

Delete the copied SVO-AP_x64 folder. Applications in the SVO-AP_x64 folder do not write 

to the registry. Therefore, deleting the folder will complete the application and 

library-related uninstallation. 
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7. SVO Board DIP switch setting 
The software in the SVO system assumes that multiple SVO boards are connected to a single 

PC. The current software allows you to select and use only one of the different SVO boards. 

In the future, we will be able to use more than one SVO board at the same time. 

You can then number the dip switch "S2" on the SVO board to identify each of the SVO 

boards when multiple SVO boards are connected. The number is from 00 to 07 and is set 

in the table below.（S2-use from number 6 to number 4） 

 

Num S2-8 S2-7 S2-6 S2-5 S2-4 S2-3 S2-2 S2-1 Device-Select About Dialog 

0 OFF OFF OFF OFF OFF OFF OFF OFF 0000 0000xxxx 

1 OFF OFF OFF OFF ON OFF OFF OFF 0001 0001xxxx 

2 OFF OFF OFF ON OFF OFF OFF OFF 0002 0002xxxx 

3 OFF OFF OFF ON ON OFF OFF OFF 0003 0003xxxx 

4 OFF OFF ON OFF OFF OFF OFF OFF 0004 0004xxxx 

5 OFF OFF ON OFF ON OFF OFF OFF 0005 0005xxxx 

6 OFF OFF ON ON OFF OFF OFF OFF 0006 0006xxxx 

7 OFF OFF ON ON ON OFF OFF OFF 0007 0007xxxx 

 

The "xxxx" will be given a number that Windows recognizes and allocate in the range 0 

to F. 

 

If you set the following settings, it can be started automatically in the HDMI version. 

With S2-7 off, start Svogenerator, set the HDMI tab, and write the settings in "Write 

Rom" to Spi-rom. 

By turning S2-7 on, it will switch to the mode of loading the setting from Spi-rom and 

launching. Therefore, it is possible to output data without having to do the setting 

from the PC again. 

The details of the setting are described in Chapter 13. 
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8. How to operate the application 
Describes that the flow of basic application operations using svogenerator and how to 

do it individually.  See also application Help for more information on application items. 

 

8.1. Application Operation Flow 

The basic flow of data output from the SVO device is shown below. You can output data 

from the SVO device by performing this procedure. For each item, refer to the following 

sections. 

 

USB Mode                     HDMI Mode 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Launching the application (SVOGenerator) 

File options (analysis information) 

settings 

Read Data file 

Data Confirmation 

Launching the application (SVOGenerator) 

 

SVO Board Selection 

 

SVO Board Setting information creation 

 

Data transmission to the SVO board 

 

End of application (SVOGenerator) 

 

SVO Board Selection 

SVO Board Setting information creation 

Data transmission to the SVO board 

SVO Board Operation 

End of application (SVOGenerator) 
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8.2. Launching the application (SVOGenerator) 

 

① 5.2 Run "SVOGenerator.exe" in the SVO-AP_x?? folder that you copied in 

"Applications, library-related installation" 

②You will see the SVOGenerator screen shown below. Verify that "Ready" appears in 

the SVOGenerator status bar. 

 
This is the end of the boot. 

 

8.3. End of application (SVOGenerator) 

 

①Click "File" → "Exit" or click the "X" button at the top right of the screen. 

 
This is the end of the application. 
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8.4. File options (analysis information) settings 

 

①Click "File" → "Option" or click the  icon on the toolbar. 

②The "File Option" dialog is displayed so 

that you can make the settings that were 

in the data file that you are reading. 

 

 

 

 

・PictureType：Specifies the color format 

of the image data. 

・1 Color bit width：Select the bit width 

to generate one color from 8, 10, 12, 16. 

YUV, RGB565, RGB24 Select 8bit, Raw is set 

according to the data. 

・The viewplayspeed is an integer that 

specifies the FPS value. At 30fps, specify 

30. 

③When you're done, click the OK button. 

 

※You can change the file options even after loading the data file. In that case, click 

the "OK" button and then perform a re-analysis of the image data based on the file option 

setting.
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8.5. Read Data file 

 

①Click "File" → "Open" or click the  icon on the toolbar. 

②The Open File dialog box appears, and then select the appropriate file. 

 
※If you open a file other than the file created in SVI, your application may behave 

erratically. 

In that case, close the application again and start again. Open the file with the 

extension ".frmt", ".frm", and ". avi". 

※For AVI files, the supported color spaces are  "YUY2",  "UYVY",  "DIB ". 

There is no compression only support. 

③Analyze the data based on the File option setting. When you're finished, you'll see 

an image. 
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※If the analysis completes successfully, the status bar displays "Analyze Complete." 

If the analysis is prematurely terminated, the status bar will display "Analyze 

Incomplete" 

※If the color is incorrect in YUV system, please try to change the order in File-option. 
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8.6. Data Confirmation 

 

① Select "View" → "Play" or the icon on the toolbar to check the data one frame 

at a time. 

 

 
②The status bar shows the current frame number and image size, so please refer to 

it as appropriate during playback. 

②If you want to check the frame of the image data while skipping "View" → "Jump to" 

If you want to check the color of the image data, see "View" → "Color Bar" 

If you want to see the header information for a file, check "view" → "file info". 

For more information on the status bar and dialogs, see SVOGenerator Help. 
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8.7. SVO Board Selection 

 

①Click "Device" → "Select" or press the "F3" on the keyboard, or the icon on the 

toolbar. 

  
②The "Device Select" dialog will appear. The identification ID of the SVO board that 

is currently connected to the USB port is displayed in the drop-down list, so select 

the ID of the board you want to control. 

 
※The ID that is displayed depends on the SVO board connected to the USB port. 

③Once you have selected the ID, press the "select" button. 

 
This is the end of the device selection. 
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8.8. SVO Board Setting information creation 

①Click "Device" → "setting" or "F4" on the keyboard or click the icon on the 

toolbar. 

  

②The "Device Setting" dialog will appear. Set each setting item. 

 
※For the above settings, see "13.device setting Details". 

※The "SAVE SET" button allows you to save the current device setting contents to any 

file. 
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※The "RESTORE SET" button can read any device setting file. 

 

④ When you're done, press the "Apply" button. 

 

This is the end of the setup. 
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8.9. SVO Board Operation 

①Click "Device" → "Control", or press F6 on the keyboard, or the icon on the 

toolbar. 

  
When the Device-control dialog appears, it forwards the frame of the minute that enters 

the SDRAM first. 

②When the "Device Control" dialog opens and the play button is enabled, it is ready 

for transfer. 

 
③If it's OK, press the "PLAY" button. 

 
 



                       SVO System Software Manual Rev1.0 

 

 

Net Vision Corp. 

 

23 

④When the transfer begins, the Play button is disabled and the Current position is 

counted up to totaloutputframes. You can exit by pressing the "STOP" button during 

the transfer. Once all the files have been transferred, the "Play" button is turned 

on again. 

 

 

8.10. Deivce Control - Play Setting 

・Play cycle ： Set to output only one cycle or output in an infinite cycle. 

Output only one cycle at off, infinite cycle at on 

・Play mode ： Sets whether to output only the memory in the board, or to transfer 

the image from the PC. 

Memory output in the off board, sequential output from PC in the on 

・Image sync ： The image of the PC side screen is updated every second at the same 

time as the output. 

It does not update it when it is off, and updates it on. 

・External Trigger ： Image output start trigger input is enabled. 

・External V/HSync ： The output is done using the V/Hsync signal of the external input 

when the image is output. 

・External PCLK ： The output is done using the PCLK signal of the external input when 

the image is output. 

・Trigger Out ： The image output trigger signal can be output from the SVO board, 

which is the master of multiple ch simultaneous output. 

・Information fps / bps ： Calculates and displays the frame rate and the bitrate from 

the settings. 

 

8.11. SVO-03 Board Firmware Update method 

Update the firmware on the SVO-03 board. 

 

Step 1．Connect the SVO-03 board to the PC and turn on the SVO-03 board. 

Step２．Start SVOGenerator.exe. 

Step３．Select the SVO-03 board to update by clicking Select on the Device menu. 

  

Step４．Click on firmware Update on the tool menu. 
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Step５．The file selection dialog is displayed, so select the so○fwxxx.bin and click the Open button. 

Step６．The mouse cursor changes to an hourglass. After a while, the Hourglass will return to the arrow and you will 

see the completed message below. 

 

Step７．Click the OK button to exit SVOGenerator. 

Step８．Disconnect the SVO-03 board from the PC and turn it off. 

 

注意：Firmware updates and FPGA updates cannot be run consecutively. 
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8.12. SVO-03 Board FPGA Update method 

SVO-03 Board FPGA update. 

 

Step 1．Connect the SVO-03 board to the PC and turn on the SVO-03 board. 

Step２．Start SVOGenerator.exe. 

Step３．Select the SVO-03 board to update by clicking Select on the Device menu. 

  

Step４．Click on the FPGA Update on the tool menu. 

 

Step５．The file selection dialog is displayed, so select the so○fpgaxxx.bin and click the Open button. 

Step６．The mouse cursor changes to an hourglass. After a while, the Hourglass will return to the arrow and you will 

see the completed message below. 

 

Step７．Click the OK button to exit SVOGenerator. 

Step８．Disconnect the SVO-03 board from the PC and turn it off. 

注意：Firmware updates and FPGA updates cannot be run consecutively. 
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8.13. SVO-03 Board Multi-Update method 

The SVO-03HDMI board updates the board with a multi-update. 

 

Step１．Connect the SVO-03 board to the PC and turn on the SVO-03 board. DSW7 turn it off. 

Step２．Start SVOGenerator.exe. 

Step３．Select the SVO-03 board to update by clicking Select on the Device menu. 

 

Step４．Click Multi Update on the tool menu. 

 

Step５．The file selection dialog appears, click the Open button to select so3mxxx.bin. 

Step６．The mouse cursor changes to an hourglass. After a while, the Hourglass will return to the arrow and you will 

see the completed message below. 

 

Step７．Click the OK button to exit SVOGenerator. 

Step８．Disconnect the SVO-03 board from the PC and turn it off. 
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9. SVO board LED lighting status 
See SVO-03 hardware specifications. 

 

10. Application Error Message list 
Errors may occur during image output or other processing. The application displays a 

message box if an error occurs and notifies the user of an error. After the error occurs, 

the process is terminated according to the processing. The following table lists error 

messages, error factors, and workarounds. 

 

10.1. Application Error 

Item number １ 

Error messages Device UnOpened 

Error content SVO Board Open process failed 

Causes of error ・The SVO board is turned off. 

・SVO Board Anomaly 

・The application is not aware of the board. 

The solution 1. Exit the application once and turn the SVO board off 

2. Turn on the board and re-launch the application 

 

Item number ２ 

Error messages Play Failure（The second line of the dialog also shows the SVOAPI 

error） 

Error content Failed to send data from the SVO device 

Causes of error ・The SVO board is performing the processing 

・The application is not aware of the board. 

The solution ・To wait for the SVO board to finish processing 

If the above cannot be dealt with, the action of item number 1 is 

performed. 

 

Item number ３ 

Error messages Shared Memroy UnOpen 

Error content SVO memory data and memory space for image display cannot be secured. 

Causes of error Lack of virtual memory space 

The solution Increase virtual memory space 

 

Item number ４ 

Error messages File Open Failure 

Error content File Open failed 

Causes of error ・The specified file cannot be opened. 

・The specified file has already been opened in another application. 

・The file cannot be found in the specified path 

The solution ・If you are using a file, quit using 

・Set the correct file path 
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Item number ５ 

Error messages Update Incomplete 

Error content Failed to update FPGA or firmware 

Causes of error ・The SVO device cannot open 

・The SVO board is performing the processing 

・Invalid file data 

The solution ・To terminate the SVO board processing 

・Check the file 

 

Item number ６ 

Error messages Not Data Analyze 

Error content Data analysis not finished 

Causes of error ・Not getting data 

・File data cannot be parsed 

The solution ・Get the data 

・Check the file 

 

Item number ７ 

Error messages Not Selected Device 

Error content SVO Board not selected 

Causes of error Not making the SVO board selection in the settings 

The solution Select the SVO board 

 

Item number ８ 

Error messages Not Idol 

Error content The SVO board is performing the processing 

Causes of error The SVO board is performing the processing 

The solution To wait for the SVO board to finish processing 

Perform a workaround for item number 1 
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10.2. SVOAPI Error 

Item number ９ 

Error messages Win32API Error（More information about the error on the second line） 

Error content Windows API Error 

Causes of error See more information 

The solution See more information 

 

Item number １０ 

Error messages Connect No Device or Power Off 

Error content The SVO board is not connected to the USB or is not turned on. 

Causes of error ・The SVO board is not connected to the USB 

・The SVO board is not turned on. 

The solution ・Verify that SVOUSB20 is recognized in Device Manager 

・To connect the SVO board 

・Turn on the SVO board 

 

Item number １１ 

Error messages Device Multi Open 

Error content Trying to open multiple SVO boards. 

Causes of error ・Trying to open multiple SVO boards. 

・Trying to open double against one SVO board. 

The solution ・Check for Double Open 

・Make sure you are not trying to open multiple SVO boards in one 

application 

 

Item number １２ 

Error messages Device UnOpened 

Error content The SVO board is not open 

Causes of error Trying to process a non-open SVO board. 

The solution ・To open the SVO board 

・Close the Control dialog and select Control on the menu. 

 

Item number １３ 

Error messages Parameter Incorrect 

Error content Abnormal configuration parameters 

Causes of error Wrong setting parameters 

The solution Checking configuration parameters 

 

Item number １４ 

Error messages FW Update TimeOut 

Error content Firmware update failed 

Causes of error ・The SVO board is performing the processing 

・Invalid file data 

The solution ・To terminate the SVO board processing 

・Check the file 
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Item number １５ 

Error messages FPGA Update TimeOut 

Error content FPGA update failed 

Causes of error ・The SVO board is performing the processing 

・Invalid file data 

The solution ・To terminate the SVO board processing 

・Check the file 

 

Item number １６ 

Error messages Image Data Not Stored In SVO 

Error content The memory of the SVO board does not store any data. 

Causes of error The memory of the SVO board does not store any data. 

The solution Transfer data to the SVO board 

 

Item number １７ 

Error messages Command Busy 

Error content The SVO board is performing the processing 

Causes of error The SVO board is performing the processing 

The solution To wait for the SVO board to finish processing 

 

Item number １８ 

Error messages Command Incorrect 

Error content Sent a non-specified command to the SVO board 

Causes of error Sent a non-specified command to the SVO board 

The solution Check Send Command 

 

Item number １９ 

Error messages Paramater Incorrect 

Error content Command parameter incorrect 

Causes of error ・Wrong command parameter value 

・Command parameter values are different 

The solution ・Checking command parameters 

 

Item number ２０ 

Error messages Command Not Supported 

Error content Sent a non-specified command to the SVO board 

Causes of error Sent a non-specified command to the SVO board 

The solution Check Send Command 

 

Item number ２１ 

Error messages Not Idol 

Error content The SVO board is performing the processing 

Causes of error The SVO board is performing the processing 

The solution To wait for the SVO board to finish processing 

Perform a workaround for item number 1 
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11. Limitations 
 

Item 

number 

Limitations Workaround 

１ If you check "Sync" in the "Device Control" 

dialog, the SVOGenerator screen will display 

the image in the SVO board data output, but 

the screen display will be delayed for the SVO 

output data. 

・Make it a high-performance PC. 

（ There is no underlying 

workaround because it is a 

processing delay） 

２ When you check "Sync" in "Device Control" 

dialog and display "File Option" dialog or 

"Device Setting" dialog during "PLAY", it 

will appear on the back of the main window 

If you want to display the "File 

Option" or "Device Setting" 

dialog, press the "ALT" key on 

the keyboard to bring it to the 

front. 

３ "Win32API Error" occurs when you perform a 

SVO board-related operation, such as "Device 

Select", and subsequent access to the SVO 

board becomes abnormal. 

Exit the SVOGenerator and turn 

off the SVO board. Then turn on 

the SVO board and start the 

SVOGenerator. 

４ If the "Device Setting" setting is different 

from the information in the image being 

analyzed, the SVO board may behave 

abnormally. 

Avoid using settings that cause 

abnormal behavior 

５ If the SVO board behaves abnormally during 

"PLAY" operation in the "Device Control" 

dialog, the Stop button will not work. 

Exit the SVOGenerator and turn 

off the SVO board. Then turn on 

the SVO board and start the 

SVOGenerator. 

６ You receive an "Not Support" error message 

when you specify an AVI file in File-open ". 

※For AVI files, the supported 

color spaces are  "YUY2",  

"UYVY",  "DIB ". It is also 

uncompressed support only. 
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12. Image data formats in frm format 
 

The corresponding image data in the SVO system is general AVI format or the FRM format 

created by the SVI system. 

The FRM format is the data output from the camera module or image sensor, with a 40-byte 

header appended to each frame. The header is recorded at the beginning of the frame. 

The data part records the output from the camera. However, the padding data is appended 

so that the number of bytes in the frame portion is divisible by 64. 

The following are the details of the FRM format image File format: 
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The image has 10-bit, 12-bit, 16-bit bytes, and is big-endian. 

 

The FRM file has a limit of 2GB, so if it is more than one FRM file, then use the FRMT 

file to manage it. The FRMT file is a text format that records the FRM file name with 

an absolute path. 

 

 Example) if you have two FRM files in a folder called Data under C drive 

C:\Data\data0001.frm 

C:\Data\data0002.frm 

Because the FRMT file is in text format, you can edit it in a text editor such as Notepad. 

Even if there are only two FRM files, it is possible to output for a long time by selecting 

multiple lines of the same FRM file as follows. The output will be output in the order 

as described in the FRMT file. 

 

 Example) if you have two FRM files in a folder called Data under C drive, and you copy 

the same file three times to respond to long-term output 

C:\Data\data0001.frm 

C:\Data\data0002.frm 

C:\Data\data0001.frm 

C:\Data\data0002.frm 

C:\Data\data0001.frm 

C:\Data\data0002.frm 

C:\Data\data0001.frm 

C:\Data\data0002.frm 
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13. Device Setting Details 

 

Describes the "Device Setting" dialog that appears in the "Device"-"Setting" menu. In 

this dialog, you can select and set four different settings depending on the tab page 

switching. 

It is a tab enclosed in the red frame of the figure below (Easy), but it is possible 

to set four kinds. 

 Easy  ：Set the image size and one blank area (X-blank). 

 Standard ：Set the image size and three blank areas (SYNC, FP, BP). 

 Advance  ：Make a fine setting for the PCLK unit. 

  Hdmi  ：Set up to operate as a SVO-03HDMI version. 

[SAVE SET],[RESTORE SET],[Apply]  buttons correspond to the current Tappage. 

 
 

The following pages show the dialog and output images from the settings on the Easy tab, 
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the Standad tab, the Advance tab, and the HDMI tab. 
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Settings and output images in the Easy tab: FullHD, YUV, 16bit output 
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Settings and output images in the Standard tab: FullHD, YUV, 16bit output 
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Settings and output images in the Advance tab: FullHD, YUV, 16bit output 
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Settings and output images in the Hdmi tab: FullHD, YUV, 16bit output 
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13.1. Sync Porality Setting (Easy tab、Standard tab、Advance tab) 

 

VSYNC：You can specify the polarity of the VSync sync period. Low active and high active 

can choose. 

HSYNC：You can specify the polarity of the HSync sync period. Low active and high active 

can choose. 

 

13.2. Sync Setting (Hdmi tab) 

 

VSYNC Polarity：You can specify the polarity of the VSync sync period. Low active and 

high active can choose. 

HSYNC Polarity：You can specify the polarity of the HSync sync period. Low active and 

high active can choose. 

HSYNC Pulse：It can be set to generate a Hsync pulse during V blank. 

 

13.3. V-Blank Setting (Easy tab) 

 
HSync Pulse：It can be set to generate a Hsync pulse during V blank. 

Blanking Code：You can set the data for V blank and H blank period. 

 

13.4. V-Blank Setting (Standard tab、Advance tab) 

 
Blanking Code：You can set the data for V blank and H blank period. 

 

13.5. Blank Setting (Hdmi tab) 
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Blanking Code：You can set the data for V blank and H blank period. 

 

13.6. Video Clock Setting (Easy tab) 

 
DCK Mode：Sets the DCK (Video Clock) that the SVO-03 outputs. 

 
DCK mode allows you to select six types as shown above. 

For more information, see "11 SDR/DDR mode settings" in the SVO-03 hardware 

specification. 

Video Clock (SDR rate)：Sets the video clock frequency at SDR rate. 

 
If there is no frequency you want to use, please contact us. 

 

1 Clock Bit Size：Sets the image data bus width per clock. 8, 16, 24, 32 can be set. 

If set to 8, it means that the D0-D7 8 bits of the data output bus are valid on a single 

pixel clock. If set to 16, it means that the D0-D15 16 bits of the data output bus are 

valid on a single pixel clock. 

If set to 32, it means that the D0-D31 32 bits of the data output bus are valid on a 

single pixel clock. The YUV output is 2 pixels in one clock. The CN5 10pin header must 

also be implemented because the CN5 is used when outputting at 32 bits. 

If set to 24, it means that the D0-D23 24 bits of the data output bus are valid on a 

single pixel clock. Because it is RGB24 only, it is necessary to implement the CN5 10pin 

header because it uses CN5 when outputting it. 

If the AVI file (DIB-uncompressed) is set to 24. 
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1 Pixel Bit Size：Sets the number of bits to make up one pixel to match the image format. 

8, 10, 12, 16, 24 are configurable. 

If set to 8, it means that 1 pixel is 8 bits.（RAW8） 

If set to 10, it means that 1 pixel is 10 bits.（RAW10） 

If set to 12, it means that one color component is 12 bits.（RAW12） 

If set to 16, it means that one color component is 16 bits.（YUV、RGB565） 

If set to 24, it means that one color component is 24 bits.（RGB24） 

If the AVI file (DIB-uncompressed) is set to 24. 

 

13.7. Video Clock Setting (Standard tab、Advance tab、Hdmi tab) 

 
DCK Mode：Sets the DCK (Video Clock) that the SVO-03 outputs. 

 
DCK mode allows you to select six types as shown above. 

For more information, see "11 SDR/DDR mode settings" in the SVO-03 hardware 

specification. 

Video Clock (SDR rate)：Sets the video clock frequency at SDR rate. 

 
If there is no frequency you want to use, please contact us. 

 

13.8. Pixel Setting (Standard tab) 

 
1 Clock Bit Size：Sets the image data bus width per clock. 8, 16, 24, 32 can be set. 

If set to 8, it means that the D0-D7 8 bits of the data output bus are valid on a single 
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pixel clock. If set to 16, it means that the D0-D15 16 bits of the data output bus are 

valid on a single pixel clock. 

If set to 32, it means that the D0-D31 32 bits of the data output bus are valid on a 

single pixel clock. The YUV output is 2 pixels in one clock. The CN5 10pin header must 

also be implemented because the CN5 is used when outputting at 32 bits. 

If set to 24, it means that the D0-D23 24 bits of the data output bus are valid on a 

single pixel clock. Because it is RGB24 only, it is necessary to implement the CN5 10pin 

header because it uses CN5 when outputting it. 

If the AVI file (DIB-uncompressed) is set to 24. 

 

1 Pixel Bit Size：Sets the number of bits to make up one pixel to match the image format. 

8, 10, 12, 16, 24 are configurable. 

If set to 8, it means that 1 pixel is 8 bits.（RAW8） 

If set to 10, it means that 1 pixel is 10 bits.（RAW10） 

If set to 12, it means that one color component is 12 bits.（RAW12） 

If set to 16, it means that one color component is 16 bits.（YUV、RGB565） 

If set to 24, it means that one color component is 24 bits.（RGB24） 

If the AVI file (DIB-uncompressed) is set to 24. 

 

13.9. Pixel Setting (Advance tab) 

 
1 Clock Bit Size：Sets the image data bus width per clock. 8, 16, 24, 32 can be set. 

If set to 8, it means that the D0-D7 8 bits of the data output bus are valid on a single 

pixel clock. If set to 16, it means that the D0-D15 16 bits of the data output bus are 

valid on a single pixel clock. 

If set to 32, it means that the D0-D31 32 bits of the data output bus are valid on a 

single pixel clock. The YUV output is 2 pixels in one clock. The CN5 10pin header must 

also be implemented because the CN5 is used when outputting at 32 bits. 

If set to 24, it means that the D0-D23 24 bits of the data output bus are valid on a 

single pixel clock. Because it is RGB24 only, it is necessary to implement the CN5 10pin 

header because it uses CN5 when outputting it. 

If the AVI file (DIB-uncompressed) is set to 24. 

 

1 Pixel Bit Size：Sets the number of bits to make up one pixel to match the image format. 

8, 10, 12, 16, 24 are configurable. 

If set to 8, it means that 1 pixel is 8 bits.（RAW8） 

If set to 10, it means that 1 pixel is 10 bits.（RAW10） 

If set to 12, it means that one color component is 12 bits.（RAW12） 

If set to 16, it means that one color component is 16 bits.（YUV、RGB565） 

If set to 24, it means that one color component is 24 bits.（RGB24） 

If the AVI file (DIB-uncompressed) is set to 24. 

 

8bit Output Mode：Set the output to CD0-CD7 or CD8-CD15 of the CN4 connector when the 

8bit output. Output to CD0-CD7 in the D0-D7 setting and output to CD8-CD15 in the D8-D15 

setting. 
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13.10. Pixel Setting (Hdmi tab) 

 
1 Clock Bit Size：Sets the image data bus width per clock. 8, 16, 24, 32 can be set. 

If set to 8, it means that the D0-D7 8 bits of the data output bus are valid on a single 

pixel clock. If set to 16, it means that the D0-D15 16 bits of the data output bus are 

valid on a single pixel clock. 

If set to 32, it means that the D0-D31 32 bits of the data output bus are valid on a 

single pixel clock. The YUV output is 2 pixels in one clock. The CN5 10pin header must 

also be implemented because the CN5 is used when outputting at 32 bits. 

If set to 24, it means that the D0-D23 24 bits of the data output bus are valid on a 

single pixel clock. Because it is RGB24 only, it is necessary to implement the CN5 10pin 

header because it uses CN5 when outputting it. 

If the AVI file (DIB-uncompressed) is set to 24. 

 

1 Pixel Bit Size：Sets the number of bits to make up one pixel to match the image format. 

8, 10, 12, 16, 24 are configurable. 

If set to 8, it means that 1 pixel is 8 bits.（RAW8） 

If set to 10, it means that 1 pixel is 10 bits.（RAW10） 

If set to 12, it means that one color component is 12 bits.（RAW12） 

If set to 16, it means that one color component is 16 bits.（YUV、RGB565） 

If set to 24, it means that one color component is 24 bits.（RGB24） 

If the AVI file (DIB-uncompressed) is set to 24. 

 

Byte Swap：Specifies the method of swapping the Bite Allinement of the data signal. 

 Mode0：Output  "D3d2d1d0" as  "D3d2d1d0"（For YUV,  "Y0UY1V" output） 

 Mode1：Output  "D3d2d1d0" as  "D2d3d0d1"（For YUV,  "UY0VY1" output） 

 Mode2：Output  "D3d2d1d0" as  "D3d0d1d2"（For YUV,  "Y0VY1U" output） 

 Mode3：Output  "D3d2d1d0" as  "D0d3d2d1"（For YUV,  "VY0UY1" output） 

 

13.11. Sync Code Setting (Easy tab) 

 
Enable Sync Code：Set whether to append SAV/EAV code. When checked, it adds. The fourth 

byte of SAV/EAV code to be added when checked is shown below. 
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13.12. Sync Code Setting (Standard tab、Advance tab) 

 
Sync code setting can be set to append SAV/EAV code to both ends of active video. 

When you check "Enable Sync Code (SAV/EAV)", you can output it by adding SAV/EAV codes. 

In this case, the VSYNC/HSYNC sync code will be output. 

EAV-[1-4] 4th, SAV-[1-4] The fourth edit box allows you to specify your own 

synchronization code. By default, the above code is outputted.  

 

13.13. Output information (Easy tab) 

 
Frame width Displays the number of horizontal video clocks in a frame. 

Frame height Displays the number of lines in the entire frame. 

FPS Displays the output frame rate. 

 

13.14. Output information (Standard tab、Advance tab、Hdmi tab) 

 
Frame width Displays the number of horizontal video clocks in a frame. 

Frame height Displays the total number of video clocks per frame. 

FPS Displays the output frame rate. 

 

13.15. Blanking Setting (Easy tab） 

 

H-Blank：Sets the horizontal blanks by the number of pixels. 

V-Blank：Sets the vertical blanks by the number of lines. 
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13.16. Video Timing Setting （Standard tab） 

 

VFP：Set the vertical front porch by the number of lines. 

VSYNC：Sets the vertical synchronization period by the number of lines. 

VBP：Sets the vertical back porch by the number of lines. 

 

HFP：Set the horizontal front porch in PCLK number. 

HSYNC：Sets the horizontal synchronization period in PCLK number. 

HBP：Set the horizontal back porch in PCLK number. 
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13.17. Video Timing Setting （Advance tab） 

 
Sets the video timing to be output. Refer to the timing chart below to set the number 

of PCLK or repeat numbers in decimal. HSPR becomes the HSP1-HSP?-HSPR of the figure below, 

and generally sets the number of lines. DEPR will be similar. DEPP, DEPR is the same as 

the width and height of the active video setting, and this setting automatically updates 

the active video setting. 

 
 

13.18. Video Timing Setting （Hdmi tab） 

 

VFP：Set the vertical front porch by the number of lines. 

VSYNC：Sets the vertical synchronization period by the number of lines. 

VBP：Sets the vertical back porch by the number of lines. 
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HFP：Set the horizontal front porch in PCLK number. 

HSYNC：Sets the horizontal synchronization period in PCLK number. 

HBP：Set the horizontal back porch in PCLK number. 

 
 

13.19. Active Video Setting （Easy tab、Standard tab、Hdmi tab） 

 
Set the image size by width (pixels), height (number of lines). 

 

13.20. Active Video Setting （Advance tab） 

 
Displays the width (pclk) and height (number of lines) of the image data. The DEPP of 

the video Timing setting, the same as the DEPR, and the values entered in the DEPP and 

DEPR are automatically reflected here. 

 

13.21. Output Image / Test （Hdmi tab） 

 

Output Image：Displays the waveform image by the value you set. Not currently available. 

Test：The value set with DIP Switch 7 turned off is reflected on the board. Because it 

is not written to the SPI-ROM, the setting is not held on the board when the board is 

turned off. 
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13.22. Read ROM / Write ROM （Hdmi tab） 

 

Read ROM：From the SPI-ROM on the board, read the previously written settings and display 

them in the HDMI tab.  It becomes available by specifying the board by Device Select. 

Write ROM：Writes the settings in the HDMI tab to the SPI-ROM on the board. It becomes 

available by specifying the board by Device Select. Because the setting is kept even 

if the power of the board is turned off, the data can be output without setting it from 

the PC again when the DIP switch 7 is turned on and the board is started. 

 

13.23. Display Name （Hdmi tab） 

 

Display Name：You can specify the name of the virtual display created by SVO-03HDMI within 

13 characters. 

 

13.24. Read Set / Write Set （Hdmi tab） 

 

Read Set：Load the settings from the .svo file. 

Write Set：You can write the setting value to the .svo file. It is possible to write 

up to five sets. 
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13.25. Input Video Timing Setting （Hdmi tab） 

 
Set the video settings for the HDMI input destination. 

H blank：Sets the number of horizontal blanks in pixels.（Even） 

V blank：Sets the number of blank lines in the vertical direction. 

W：Sets the number of pixels in the horizontal direction.（Even） 

H：Sets the number of lines in the vertical direction. 

Clip_X：Sets the horizontal start coordinate for clipping.（Even） 

Clip_Y：Sets the vertical start coordinate for clipping. 

Pixel Freq：Select the pixel frequency for the monitor from below. 

27MHz、54MHz、72MHz、74.25MHz、108MHz 

V Freq：Calculates and displays the refresh rate from the width, height, and above settings 

in the Active Video setting group. If this calculated value is not supported with the 

HDMI signal output device, the video cannot be received properly. 

 

If you want to clip to an input image from HDMI, set the clip width and clip height in 

clip_x, clip_y, start coordinates, Active Video setting width, height. 

If you do not want the clip, clip_x and clip_y set it to 0. Naturally, the width and 

height of the active video setting are the same as the input video Timing setting W and 

H. 
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14. Device Control Details 

 

Describes the settings and behavior of the "Device Control" dialog that appears in the 

"Device"-"Control" menu. 

 

 
 

14.1. Play Setting 

In the image output timing set with "Device-Setting", we set the output of each image 

frame. It also uses an external synchronous output and multiple SVO boards to configure 

synchronous output. 

 

・"Play cycle" sets whether the imported image file is output as infinite or only once. 

It outputs it only once by the check off, and it outputs it infinitely by check on. 

 

・"Play mode" sets whether the image data is always sent from the PC or only the image 

data stored in the memory in the SVO board. When the check is off, the image data stored 

in the memory in the SVO board is output, and the image data is always sent from the 

PC when it is checked on. If the image file does not fit in the memory of the SVO board 

when the check is off, only the amount of memory from the beginning of the image file 

is stored in memory. 

 

・"Image Sync" sets whether the image display screen is updated during image output. 

Check off does not update the screen. If checked on, refreshes the screen every second. 

However, play mode is enabled when it is checked on. 

 

・ "External trigger" will enter the external trigger signal connected to the 

general-purpose input port (P4) of the SVO board and set the image output to start. If 

check off, outputs without an external trigger. When checked on, the image output by 

an external trigger is performed. 
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・"External V/hsync" sets the external vsync signal connected to the general-purpose 

input port (P4, P5) of the SVO board, the external HSync signal, and the image output 

at the timing of the sync signal entered. Outputs without external V/hsync input when 

check off. The image output is performed at the external V/hsync timing in case of check 

on. If this check is on, unconditionally "External PCLK" will also be checked on and 

can not be selected. VSync, HSync accept each input is the following pin. 

○External VSync signal Input pin；Connector4 11pin 

○External HSync signal Input pin；Connector4 50pin 

○External PCLK signal Input pin；Connector4 9pin 

 

・"External PCLK" will enter the external PCLK signal connected to the general-purpose 

input port (P3) of the SVO board and set the image output at the timing of the PCLK signal 

entered. Output without external PCLK input when check off. The image output is done 

by the external PCLK timing when checking on. 

 

・ "Trigger out" sets the output of an external trigger signal connected to the 

general-purpose output port (P0) of the SVO board. No external trigger output in case 

of check off. There is an external trigger output in the case of check on. External trigger 

outputs are used in operations that assume synchronous output from multiple SVO boards. 

Outputs an external trigger signal from the master SVO board. The external trigger input 

including the master itself is performed, and the image output is started as an image 

output start trigger signal input. 

 

The CN4 3-pin (P0) is an external trigger output signal and the CN4 11 pin (P4) is an 

external trigger input signal. When synchronizing output is performed on the four SVO 
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boards shown above, the image output is started as  "Extrenal trigger on" in Svogenerator, 

which controls the SVO board of Ch 4 from Ch 2. Then, the master of CH1 will start the 

image output with the "Extrenal trigger on", and after 100msec wait, the external trigger 

output is done. From Ch 1 to Ch 4, the SVO board receives an external trigger input and 

produces an image output. 

 

・Information fps / bps：Displays the output frame rate and output bit rate. 


